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1. Purpose of use
This user manual is strictly intended for the users of Qualified certificates for qualified electronic
signature: Verba Sign PKI token and Verba Sign Pro PKI token.

Those users who have obtained Gemalto IDPrime PKI token, with a generated pair of keys and a
certificate, in a Local Registration Authority (LRA) of Certificate Authority KIBS (CA KIBS), and need to
access the certificate trough Microsoft Internet Explorer, Google Chrome or Mozilla Firefox.

Definitions:
QSCD = Qualified Signature Creation Device
Gemalto IDPrime PKI token can refer to:
- Gemalto IDPrime MD 840 token (QSCD)
- Gemalto IDPrime MD 940 token (QSCD)
- Gemalto IDPrime .NET token (non QSCD, used in legacy certificates profiles)
The same software is used for all types of tokens.

The certificate is installed on Gemalto IDPrime PKI token, in the presence of the user, using a software
for secure certificate management. This software guarantees that the private key is solely stored on
the Gemalto IDPrime PKI token, which is delivered to the user.

NOTICE: The Gemalto Classic Client software is not applicable for Gemalto IDPrime token!

2. How to install the middleware software used for the Gemalto IDPrime PKI
token?

2.1 Intro

In most of the cases, without additional middleware software installation, only with plugging the
Gemalto IDPrime PKI token in your computer with Windows operating system, Plug&Play installation
is initialized, and the certificate is loaded in your Internet Explorer web browser.

However, for better support for most recent versions of Windows 11 and Windows 10, our
recommendation is to install the special package SafeNet Authentication client (SAC Client) from the
following links:

For x86-based PC, for 32-bit operating system:
https://www.kibstrust.com/Storage/Support/Software/KIBSTrust-SAC-x32-10.8-R6.msi

For x64-based PC, for 64-bit operating system:
https://www.kibstrust.com/Storage/Support/Software/KIBSTrust-SAC-x64-10.8-R6.msi

Notes:

This software package replaces the need for separate installation of minidriver and PKCS#11 library.
For Legacy, those packages are still available on our web site https://www.kibstrust.com/en-
GB/Home/Support/:

1. You can download the older version of minidiver from the section “Software & Drivers”, part
“Minidrivers for Gemalto ID Prime (.NET & MD) PKI tokens”
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2. Youcan download the older version of PKCS#11 library, from the section “Software & Drivers”,
part “PKCS#11 Library for Gemalto ID Prime (.NET & MD) PKI tokens”

IMPORTANT: Before installation of SAC Client, you need to uninstall minidriver and PKCS#11 library!

To make a right choice of the middleware packet (32 or 64-bits), check the type of your computer’s
operating system by following the next procedure:

Click Start->Programs->Accessories->System Tools->System Information.
In the part: OS name is the information about the operating system version.
In the part: System Type, there is one of the following information:

- x86-based PC, for a 32-bit operating system
- Xx64-based PC, for a 64-bit operating system

Note: If you are our customer, you can obtain middleware software for Gemalto IDPrime PKI tokens
for MAC and Linux Operation systems, after request via e-mail message to helpdesk@kibstrust.com.

2.2 Installation of middleware software on Windows operating system

Supported Windows operation systems for SafeNet Authentication client version 10.8 R6 are:

- Windows 11 (64-bit), Windows 10 (32-bit, 64-bit), Windows 8.1 (32-bit, 64-bit), Windows 8
(32-hit, 64-bit);

- Windows Server 2019 (64 bit), Windows Server 2016 (64 bit), Windows Server 2012 and 2012
R2 (64-bit), Windows Server 2008 R2 SP1 (32-bit, 64-bit), Windows Server 2008 SP2 (32-bit,
64-bit)

The installation process is very simple, following the screens and predefined values. The installation
starts with double click of proper installation file (32-bit or 64-bit), and proceeds by clicking the Next
button (Figure 1).

ﬁ SafeNet Authentication Client 10.8 R6 Setup X

Welcome to the SafeNet Authentication
THALES Client 10.8 R6 Installation Wizard

l The Setup wizard will install SafeNet Authentication
Client 10.8 R6 on your computer. To continue, click
Next.

It is strongly recommended that you close all
Windows programs before running the Setup wizard

< Back Cancel

Figure 1

On next window, leave the predefined interface language — English, do not select “Use the existing
configuration settings” and then click Next (Figure 2):
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ﬁ SafeNet Authentication Client 10.8 R6 Setup >

Interface Language

Selectthe interface language. T H ,\ L E S

Selectthe SafeNet Authentication Client 10.8 R6 interface language:
English ~

Setup has detected existing configuration settings

||:|iJse the existing configuration settings:

InstallShield

Figure 2

On the next window, select “l accept the terms in the license agreement”, and then click Next (Figure
3):

ﬁ SafeNet Authentication Client 10.8 R6 Setup X
License Agreement
Please read the following license agreement carefully TH A L' E S
THALES SOFTWARE LICENSE TERMS .

SafeNet Authentication Client

Legal notice:

Thales software is not sold; rather, copies of Thales software are licensed all
the way through the distribution channel to the end user. UNLESS YOU HAVE
ANOTHER AGREEMENT DIRECTLY WITH THALES THAT CONTROLS AND

ALTERS YOUR USE OR DISTRIBUTION OF THE THALES SOFTWARE, THE TERMS ¥

@il accept the license agreement
(O 1 do not accept the license agreement

InstallShield

Figure 3

Leave the predefined installation path and choose Next (Figure 4):
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ﬁ SafeNet Authentication Client 10.8 R6 Setup >

Destination Folder

Click Next to install to this folder. or click Changeto T HALE S
install to a different folder.

D Install SafeNet Authentication Client 10.8 R6 to:
C:\Program Files\SafeNef\Authentication' Change...

InstallShield

Figure 4

On next window (Figure 5), click Install:

ﬁ SafeNet Authentication Client 10.8 R6 Setup X

THALES

The wizard is ready to begin installation.

Click Install to begin the installation.

If you want to review or change any of your installation settings, click Back.
Click Cancel to exit the wizard.

InstallShield

<Back [ Wingial ] | Cancel

Figure 5
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ﬁ SafeNet Authentication Client 10.8 R6 Setup X

Installing SafelNet Authentication Client 10.8 R6

THALES

The program features you selected are being installed

Please wait while the InstallShield Wizard installs SafeNet
Authentication Client 10.8 R6. This may take several minutes.

Status:
Starting services

Wait for installation process (

Figure 6):

The program features you selected are being installed.

InstallShield
ﬁ SafeNet Authentication Client 10.8 R6 Setup - X
Installing SafeNet Authentication Client 10.8 R6 T E S

Status:
Starting services. ..

InstallShield

Please wait while the InstallShield Wizard installs SafeNet
Authentication Client 10.8 R6. This may take several minutes.

< Back

Next =

- Cancel

Figure 6

When the installation is finished, chose Finish (Figure 7):
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ﬁ SafeNet Authentication Client 10.8 R6 Setup X

SafeNet Authentication Client
10.8 R6 has been successfully
\ installed.

THALES

Click Finish to exit Setup.

< Back FEinish ] Cancel

Figure 7

If you get the message like in Figure 8, restart the computer!

ﬁ Installer Infarmation

You must restart your system for the configuration changes made
to SafeNet Authentication Client 10.7to take effect. Click Yesto
restart now or No if you plan to restart manually later.

Yes ] Mo

Figure 8

IMPORTANT: The procedure of installing the middleware software described in part 2.2 should be
repeated on each PC on which you intend to use the Gemalto IDPrime PKI token.

3. Check the content of the Gemalto IDPrime PKI token

=

After the installation of middleware software SAC, you will notice * jcon in the right down corner of

|z§\|
your screen. When you plug in your PKI token, the icon gets fulfilled red color: = . When you right
click on the icon, you can see the following information about Your PKI token, like in Figure 9:

Tools

About

Change Token PIN

Certificate Information
Exit
Figure 9
If You choose “Certificate Information”, You should get the Figure 10.

Under “User” type, the user certificate is shown.
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Under “CA” type, the intermediate certificates are

shown.

You can open certificates by double click and check their characteristics.

';5;' Token Certificate Information: Lile Gagovska *

1 THALES
3 KIBSTrUSt SafeMNet Authentication Client

Type lssued To Status Serial Number Container name

EJ User Lile Gagovska Valid 2BB97FEACDC...  p11H5f477dbé...

L"ﬁgJCA Battimore CyberTrust Root Walid 02000089

L‘ﬁg.‘CA KIBSTrust lssuing CA for e-Signatures  Valid OFSF12D3FC3...

< >

Log On Close

Figure 10

4. Change of user PIN

|z§“|
You can change Your current PIN with right click on the icon ** , where you can choose “Change
Token PIN“ and you can set new PIN, by entering current PIN, see Figure 11:

';:-'g;' Change PIN: Lile Gagovska

" KIBSTrust

*

THALES
SafeMNet Authentication Client

Curmrent Taken PIN: ||

New Token PIN: |

Corfirm PIN:

The new passward must comply with the qualty settings defined on the token.

A secure password has at least 8 characters, and contains uppercase letters, lowercase letters,
numerals, and special characters (such as !, §, &, %),

Current Language: EN

Enter your curent password.

oK Cancel

Figure 11
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|'§'|
You can reach the same “Change Token PIN” menu (Figure 11) trough right click on icon “* then

choose Tools, and (Figure 12Error! Reference source not found.) choose ,,Change Token PIN”.

(S) SafeMet Authentication Client Taols

. KIBSTrust

secure in the digital world

‘V Lile Gagovska SCMP

- X
THALES
SafeNet Authentication Client
@OI?26
/ Rename Token
| dededede Change Token PIN |

Unlock Token

‘™
® Delete Token Content

View Token Info |

thalesgroup.com

5. Token information

Figure 12

With right click on icon ** we choose , Tools“(Figure 11Error! Reference source not found.) then
»View Token Info” and you will get your PKI token information, as shown on Figure 13 .

@ Token Infermation: Lile Gagovska X
< THALES
E KlBSTI‘USt SafeNet Authentication Client
Token name Lile Gagowvska SCMP -~
Token category Hardware
Reader name Generic EMY Smartcard Reader 0
Serial number (PKC5#11) 0B41E1DA3DCSETSS
Free space (minimum estimated) 66108
Card 1D (GUID) Ox3DCO017936442A773DC0017936442A77
Product name |DPrime 940
Card type |DPrime
Applet Version |IDPrime Java Applet 4424
Mask version G286
Token PIN Present
Token PIM retries remaining 5
Maximum Token PIN retries 5
Token PIM expiration Mo expiration
Administrator PIN Present
Administrator PIN retries remaining 5
Maximum administrator PIN retries 5
FIPS NAA
Common Criteria (CC) CC EAL5+ /PP QSCD
Token unlock ohiects Administrator N
Copy QK
Figure 13
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6. How to check if the certificate from my Gemalto IDPrime PKI token is
shown in Internet Explorer?

6.1 How to check if the certificate is shown in Internet Explorer
You need to insert the Gemalto IDPrime PKI token in the PC, which has the SAC middleware software
installed, according to part 2.2 of this user manual.

Open the web browser Internet Explorer and from the menu, choose Tools ->Internet Options
(Figure 14)

Print >
File >
Zoom (100%) ¥
Safety >

Add site to Apps

View downloads Ctrl+J
Manage add-ons

F12 Developer Tools

Go to pinned sites

Compatibility View settings

Internet options

About Internet Explorer

Figure 14
In the new window, choose the Content tab and click on Certificates (Figure 15).
| Intemet Options ? x

General  Security  Privacy  Content  Conneckions Programs  Advanced

Cartficates
Use certificates for encrypbed connections and identification.

[ Cewrssistate || Corticates | Publishers

AukcrComplets

fugoComplete stores previous entries Settings
3} on webpages and sugoests matches
For wou,

Feeds and Web Shoes

"] Feeds and Web Skors provide updated Settings
3 conbent froem websies that can be
read in Inberret Explorer and other
progranms.

BAA,

0K Cancel

Figure 15

Your certificate should be in Personal tab (Figure 16).
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Certificates x

Intended purpose: <All= w

Personal  Other People  Intermediate Certification Authorities  Trusted Root Certification * | *

Issued To Issued By Expiratio,.. ™
05.9.2021

59 ImePKIToken PrezimePKIToken KIBSTrust Issuing CA for e-Signatures

Import... Export... Remove Advanced

Certificate intended purposes

Client Authentication, Secure Email

Figure 16

When double-click on the certificate you should get a preview like on Figure 17, which shows
information regarding the certificate.

n  Certificate x

General Details  Certification Path

g Certificate Information

This certificate is intended for the following purpose(s):

» Proves your identity to a remote computer
«0.4.0.194112.1.2
*0.4.0,2042.1.2|

*Refer to the certification authority's statement for details.

Issued to: ImePKIToken PrezimePKIToken
Issued by: KIBSTrust Issuing CA for e-Signatures

Valid from 04.9.2020 to 05.9.2021

H‘? You have a private key that corresponds to this certificate.

Issuer Statement

O

Figure 17
After that, check the Certification Path. There are two possible previews:

1. If the preview is like on Figure 18 all the settings for the certificate are OK and it is ready for
use.
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n  Certificate e
General Details Certification Path

Certification path

5] KIBSTrust Root CA G2
---_PJ KIBSTrust Issuing Qsig CA G2

ERER] ImeAdyTret PrezimeAdvTret’s KIBS AD Skopje ID

View Certificate

Certificate status:

F‘his certificate is OK.

Figure 18

2. If the preview is like on Figure 19 (only the name and surname are shown) or only one root
certificates is shown, you must continue with part 6.2.

n Certificate *
General Detsils Certification Path

Certification path

[&=} (mePKIToken PrezimePKIToken

View Certificate

Certificate status:

F‘h\s certificate is OK.

Figure 19

6.2 Installation of root certificates in Internet Explorer

If some of KIBSTrust root certificates is missing in the certificate chain, you can download them from
section Root certificates from https://www.kibstrust.com/en-GB/Home/Support/ and please install
them:

KIBSTrust Root CA G2 (install in Trusted Root Certficate Authorities)
KIBSTrust Issuing Qsig CA G2 (install in Intermediate Certificate Authorities)

After importing the two root certificates, make sure you get a preview as in one of the pictures in
Figure 18!
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The installation is described in one of the FAQ on the following link: https://www.kibstrust.com/en-
GB/Home/Support “How to install root certificates in Internet Explorer”.

7. Does my certificate from the Gemalto IDPrime PKI token is shown in Google
Chrome?

7.1 Check if the certificate is shown in Google Chrome
Gemalto IDPrime PKI should be inserted in the computer where the middleware software is installed,
according 2.2 from this manual.

Open Google Chrome, then Settings, Privacy and Security, Security, Manage Certificates. Open User
Certificate store, as is open in Internet Explorer.

8. How to check if the certificate from my Gemalto IDPrime PKI token is
shown in Mozilla Firefox?

8.1 Adding a Gemalto IDPrime PKI token as a security device
To access the certificate issued on Gemalto IDPrime PKI| token, in Mozilla Firefox, beside the
installation of middleware software, you need to add proper security device.

From the browser menu click on the right upper button and select Options (Error! Reference source
not found.Figure 20):

- & Google bl 3 Options

€ c B @@ httpsy//wgooglecom s e @ gy | Q searcn mn o=
£ Signinto Sync
ﬁ New Window Ctrl+M
©0 Mew Private Window Ctrl+Shift+P

B Restore Previous Session

Zoom - 80%

Google “ %

s
a

I\ Library >
& Add-ons Crl+Shift+A

m ¥ Options
7 Customize...
MpeGapyeare Ha Google Me cneaw cpefa Open File... Ctrl+Q

Save Page As... Cirl+§

Google nowyan so: English & it
Q, Find in This Page... Ctrl+F
More >
Web Developer >
@ Help >
) Exit Ctrl+Shift+Q
Figure 20

In the new tab select the Privacy & Security option from the menu on the left side, go down and click
on the Security Devices button (Figure 21)
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(_

¢ @ © Firefox  aboutipreferences#privacy 90% V¥ | | Q Search o =

~

'ﬂ- General
Q Search

a Privacy & Security v Block dangerous and deceptive content Learn more

Security

Deceptive Content and Dangerous Software Protection

s Firefox Account v Block dangerous downloads

¥ Warn you about unwanted and uncommon software

Certificates

wWhen a server requests your personal certificate
Select one automatically

® Ask you every time

Query OCSP responder servers to confirm the current validity of Wiew Certificates...
v

certificates
@ Firefox Support

Figure 21

In the next window click Load (Figure 22)

Device Manager x

+ NS5 Internal PXCS #11 Module
Generic Crypto Servees

Software Security Drvice
~Builtin Roots Module
Builtin Object Token Load

Enable fIPS

oK

Figure 22

In the new window, in the field Module Name enter ,Gemalto IDPrime“ and click Browse (Figure 23)
in order to find the required file.

@ Load PKCS#11 Device — >

Enter the information for the module you want to add.

Module Mame: | Gemalto IDPrime

Module filename: | | Browse...

Cancel

Figure 23

The file is located in:
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- C:\Program Files (x86)\Gemalto\IDGo 800 PKCS#11 (for 64-bit OS), or

- C:\Program Files\Gemalto\IDGo 800 PKCS#11 (for 64-bit OS).
Select the file IDPrimePKCS11.dll for 32-bit version of Mozilla Firefox (or IDPrimePKCS1164.dll for
64-bit version) and click Open (Figure 24) and then click OK (Figure 25).

@ Choose a PRCS#11 device to load *
< v | C\Program Files (xBEMGemaltoy/DGo 800 PKCS#'I1| V| [¥] Search [DGo 200 PKCS#1 y)
Organize v New folder = @ @
@ Docurmerts o Marne Date rmodified Type Size
& Downloads 2] 1DPrimePKCS11.dlI 121220131050 Application extens... 1,988 K
J Music 4] IDPrimePKCST164.dIl 12.12.2013 10:50 Bpplication extens.., 2,503 KH
&= Pictures
B videos
‘e Local Disk (C:)
e Wolume (B
v o€ >
File name: | IDPrimePKCST1.dll w| i Files ¢ v

Figure 24

@ Load PKCS211 Device — 4

Enter the information for the medule you want to add.

Module Name: | Germalto IDPrime |

Maodule filename: |C:\Prngram Files(xﬂﬁ)\| | Browse... |

0K Cancel

Figure 25

Your PKI token Gemalto IDPrime is now shown in the list on the left side of the window (Figure 26)

£k Dptman < Lk

& L Bt pr e erar R adeanond c

P .

ime prezime

w s R0ty Mol

Figure 26

Click OK two times to close the window.
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8.2 How to check if the certificate from the Gemalto IDPrime PKI token is shown in
Mozilla Firefox?

The Gemalto IDPrime PKI token should be inserted in the PC. Open the web browser Mozilla Firefox,
click on the right upper button, and select Options, select the Privacy & Security option from the
menu on the left side, then click on the button View Certificates (Figure 27).

&« c o © Firefox  about:preferences#privacy 80% 17 N @ =
"~
ﬂ General
ﬁ Home
Security
Q Search

Deceptive Content and Dangerous Software Protection

| Block dangerous and deceptive content Learn more

c Firefox Account | Block dangerous downloads

+'| Warn you about unwanted and uncommon software

Certificates
When a server requests your personal certificate

® ' Select one automatically

Ask you every time

v Query OCSP responder servers to confirm the current validity of

certificates
& Extensions & Themes Security Devices...

@ Firefox Support

Figure 27

In the next window (Figure 28) a password is required, DO NOT ENTER ANYNOTHING, just click OK or
Cancel:

Password Required X

0 Please enter the rmaster password for the -ioksantiza Shunes e

Cancel

Figure 28

Your personal certificate is located in Your Certificates (Figure 29)
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Certificate Manager

Your Certificates People Servers Authorities

You have certificates from these organizations that identify you
Certificate Name Security Device Serial Number Expires On

~ KIBS AD Skopje

Ime Prezime Ime Prezime: 00:A2:0F:FO:1F:FF:D... Monday, Decem...
Backup All.. Import...
oK
Figure 29

8.3 How to install root certificates in Mozilla Firefox?

Save locally root certificate’s files from:

KIBSTrust Root CA G2

KIBSTrust Issuing Qsig CA G2,

Than you can go to Options, Privacy & Security, View Certificates, Authorities chose Import and
browse to local path where you have saved the certificates and import them one by one.

The installation of root certificates more detailed is described in one of the FAQ on the following link
https://www.kibstrust.com/en-GB/Home/Support “How to install root certificates in Mozilla
Firefox?”

* %k %k
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